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1. Medway Map Service 
 
Medway Map Service provides access to an extensive variety of map information 
ranging from Ordnance Survey topographic base maps to aerial photographs and 
map layers created by Medway Council.  
 
Medway Map Service contains a number of maps that show the location of facilities 
(such as schools and libraries etc.), electoral boundaries (such as wards and polling 
districts), routes (cycle routes, roads and footpaths) and many other features. Each 
map is made up of a number of ‘map layers’ which display a particular feature such 
as schools or libraries.  
 
The map-based information can be displayed at varying scales and for different 
locations. You can zoom in and out, pan (navigate) around the map or find a specific 
location by using the address search. Within a map, map layers can be turned on 
and off and map features can be queried. You can copy the map image into a Word 
document or print it directly from your local printer. 
 
 
2. Starting Medway Map Service 
 
There are two ways to enter Medway Map Service depending on the map area you 
initially want to view.  
 
You can choose to open the Medway Map Window to display:  
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a. The full Medway area map (see below) 
b. A specific location (dealt with under Section 4.2.2 – Searching for locations) 

 
Note:  

 For each new session using Medway Map Service, a disclaimer is displayed. 
Please read this disclaimer before proceeding to use the service, and then 
click Click here to proceed with search if you wish to continue. 

 
Opening full Medway area map 
 
On the Medway Map Service front page: 
• Click on Click here for Maps or  
• Click on the map showing London and Kent  
 

  
 

The following page will be displayed showing the topographic Base Maps.  
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3.   The Medway Map Service user interface 
 
 
 
 
 
 

 
 

 
 

 
 
 

To get help on how to use each of the functions click on the help tips button .  To 
view the entire help document click on Help to the left of the Search drop down box. 
 
 
4. Viewing and manipulating the maps 
 
4.1  Selecting a map to view 
 
To select one of the maps in Medway Map Service: 
• Click on the drop down button under Maps and the range of map options will be 

displayed 
• Click on the appropriate map 
 
The Build a Map tool will open. This might take quite a while - check progress in the 
progress bar in the lower right hand corner of the screen. 
 

Navigation & Zoom 
Tools 

For moving and resizing 
the map in the map 

window 

Map drop down 
list 

Used to select a 
map to display 

Tools drop 
down list 

Used to select 
from a range of 

tools 

Info Box 
 Displays information 
for the tool currently 

in use 

Search Facilities 
To search for a map 
location by address, 

postcode, locality etc. 

Map Window
Displays currently 

selected map 

Status Bar 
Length of blue bar 

indicates progress of 
current function 

Coordinate Display 
Displays grid location of 

the cursor when placed in 
the map window 
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Each map is composed of a group of ‘map layers’. Use the Build a Map tool to select 
the map layers that you want displayed in the map: 
• Click in the tick box to the left of the map layer that you want to display. Ensure 

that a tick is displayed in the box 
• Repeat for all the map layers you want to display 
• Click on the Draw Map button. 
 
 
4.2  Moving about the map 
 
Note:  

 You can find the grid location of features currently displayed in the map 
window by placing the cursor over them and noting the grid coordinates 
displayed in the lower left hand corner of the screen. 

 
4.2.1  Navigating and zooming 
 
You can move in, out (zoom) and around (navigate) the map.  
 
Navigating 
There are two tools for navigating around the map: 
• Click on the green N, E, S and W buttons to move the map North, East, South 

and West. 
 

 
 

• Click in the Re-centre option button and click on the map to re-centre the map on 
the location where the cursor was clicked. 

 
Note:  

 You can only use the Re-centre option when ‘Layers’ or ‘Legend’ are selected 
in the Tools drop down list. 
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Zooming 
You can zoom into and out of the map using a number of tools. Note that some of the 
layers in the maps are scale dependent - they only display when the map is at a 
certain scale. Therefore, as you zoom into or out from a point, different maps will be 
displayed depending on the selected scale. More detailed maps are shown the closer 
you zoom in. 
 
Notes on scale: 

a. A map displayed at a small scale (e.g. 1:200000) shows less detail and 
smaller map features but covers a larger area.  

b. A map displayed at a large scale (e.g. 1:1250) shows more detail and larger 
map features but covers a smaller area. 

 
To zoom further into a location to see a smaller area in greater detail:  
• Click on the Zoom In option button in the navigation box 
• Click on the map to zoom in and re-centre the map on the location where the 

cursor was clicked. 
 
To zoom further out from a location to see a larger area in less detail:  
• Click on the Zoom Out option button in the navigation box 
• Click on the map to re-centre the map on a new location and to zoom out from 

the location. 
 
Alternatively, you can select any of the map display scales from the drop down box. 
• Click on the drop down button to the left of the Enter Scale text box 
• Click on a scale value and wait for the map to be redisplayed 
 
If you want to zoom to a scale not listed in the drop down box you can enter it into the 
Enter Scale text box: 
• Click in the text box and delete the ‘Enter Scale’ text  
• Type in your chosen scale (e.g. if the scale you want is 1:2000, type 2000 in the 

text box) 
• Click on the Refresh button. 
 
Note:  

 You can only use the Zoom In and Zoom Out options and the drop down 
scale list when ‘Layers’ or ‘Legend’ are selected in the Tools drop down list. 

 
4.2.2  Searching for locations – using the address gazetteer 
 
A specific location can be selected and displayed using the Medway Map Service 
search facility to search Medway’s address gazetteer. 
 
Use the Search text box (see Section 4.2.2.1) to search for a location by one, or a 
combination of: 

a. postcode 
b. street  
c. address (house name/number + street) 
d. locality (e.g. Rainham, Chattenden etc) 

 
Use the Other Searches drop down list (see Section 4.2.2.2) to search for a: 

a. key location in Medway (Take Me To option) 
b. specific address (Advanced Search option) 
c. grid reference location (Grid Ref option) 



Medway Map Service Help.doc 
 

6

 
Note:  

 When running Take Me To and Grid Ref searches Medway Map Service 
always reverts to displaying the original Base Maps so, in general, it is best to 
run the search before selecting maps and map layers to display. 

 
4.2.2.1  Search 
 
• Type the name of the item you are looking for in the Search text box using the 

following guidelines:  
 to search for a postcode, type the full code e.g. ME4 4YH 
 to search for a street, just type the street name e.g. High Road. Note: you 

cannot use this Search function to search for streets whose names contain 
more than two words, e.g. St. Peter Street, Yellow Brick Road, or streets 
which don’t end in a standard ‘street’ description, e.g. The Mallings. You must 
use Advanced Search for these type of street names (see Section 4.2.2.2.). 

 to search for an address i.e. a property number on a street, the number must 
be typed, followed by a comma and then the name of the street, e.g. 14, High 
Street. 

 

 
 
• Press the return key on your keyboard or  
• Click on the ‘Go’ button. 
 
If the location is found the result of the search will be displayed. First: 
• Use the Maps drop down list (above the list of returned locations) to select a map 

to display the selected location.  Make sure that you wait sufficient time for the 
map to be selected (check the status bar for progress) otherwise Base Maps will 
be selected by default. 

 
You can then either: 
• Click To Map to go to the postcode, street, locality or single returned address 

location directly. 
 
The property, street, postcode or locality is shown on the map as a red circle. 
 
or 
• Click on Properties to show all addresses where more than one were returned by 

the search for the postcode, street or locality  
• Select the address from the properties drop down list and then click on To Map  
 
The property is shown on the map as a red circle. 
 
To remove the red circle: 
• Click on the drop down button under Tools and click on ‘Layers’ or ‘Legend’ 
• Scroll to the bottom of the layer list displayed in the Layer Info box, below the 

tools drop down list 
• Click on the Remove Overlays button at the bottom of the layer list. 
 
4.2.2.2  Other searches 
 
The Other Searches drop down list contains three options: 
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Take Me To – to search for a common/key location in Medway such as a town 
centre, the main council offices, etc.  
Advanced Search – to search for a specific address  
Grid Ref – to search for a specific location using grid references. 

 
• Click on the Other Searches drop down button  
• Select the type of search you want to make from the drop-down list 
• Click on the ‘Go’ button. 
 
Depending on the search option selected, do one of the following things: 
 
Take Me To 
• Select a common/key location from the General Locations drop down list 
• Click on the ‘Go’ button and the location will be displayed on the map with a red 

circle. 
 
To remove the red circle see Section 4.2.2.1. 

Advanced Search 
• Fill in the address, using the instructions given 
• Click on the ‘Find Address’ button to search for the address 
  

 
 

Notes: 
 For streets starting with the word ‘Saint’ type ‘St.’. (make sure you add a full 

stop after the St). 
 It is best not to add any other punctuation marks to the address text as these 

are not usually included in the gazetteer records. 
 
For further instructions see Section 4.2.2.1. 
 
Grid Ref 
• Type in a six digit grid coordinate in the east coordinate text box (for example: 

573922) and  
• Type in a six digit grid coordinate in the north coordinate text box (for example: 

168933) 
• Click on the ‘Find Grid Reference’ button. 
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4.3  Selecting the layers on a map 
 
You can select, and change, which map layers you want displayed in a map. You can 
do this in two ways: 
 

Using the Build a Map tool  
Using the Layer tool  
 

Both tools can be selected from the Tools drop down list.  
• Click on the drop down button under Tools and click on the appropriate tool from 

the list. 
 
Section 4.1 describes how to use the Build a Map tool.  
 
The Layer tool displays a list of all the map’s map layers in the Layer Info box, below 
the tools dropdown list. A tick box is displayed to the left of each layer. A tick in the 
box indicates that the layer is visible. To change the ‘visibility’ of a map layer: 
• Click in the tick box  
• Click on the ‘Refresh’ button if you have ticked a new map layer 
  
Notes: 

a. Some of the layers, such as aerial photographs, are only visible at certain 
scales 

b. If a map is below another in the list of layers it will be displayed on top and 
might cover the other maps up. For example if the aerial photo layer is turned 
on it will cover the underlying Ordnance Survey maps. 

 
Once you have selected your map layers, use the Legend tool (selected from the 
Tools dropdown list – see above) to display the legend key in the Legend Info box for 
all those layers that are currently displayed in the map window. The legend key 
shows you what colour the different map layers are displayed in. Scroll down the list 
to see the lower layers. Note that the base maps do not display a legend colour.  
 
 
5.  Querying the map-based information 
 
5.1  Using the Identify tool 
 
The Identify tool allows you to find out more information about items displayed on the 
maps such as the name, and the category. For example, if you select a school you 
can find out the name of the school and if it is a primary or a secondary school, etc.  
To query an item on the map: 
• Make sure that the layers that you want to identify features on are switched on 

(using the ‘Layer’ tool (Section 4.3) or ‘Build A Map’ tool (Section 4.1) 
• Zoom into the item(s) on the map  
• Click on the drop down button under Tools  
• Click on ‘Identify’ and a list will appear showing which map layers can be queried 

in the current map.  
• Click on the item on the map you wish to query and the results will be displayed 

on the left hand side in the Results box, under the Tools drop down list. 
 
Notes:  

 You can’t use the zoom or navigation tools when the Identify tool is selected. 
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 You can only identify features on visible layers and not all layers contain 
features that can be identified. 

 
5.2  Using the Radius tool 
 
The radius tool allows you to select and identify a range of map items within a certain 
radius of an object. To use the Radius tool: 
• Make sure that the map layers containing items for identification are set to visible 

(see Section 4.3). 
• Click on the drop down button under Tools and click on ‘Radius’ from the list. The 

Radius Info box is displayed below the Tools drop down list. 
 

 

 
 
• Select a radius from the Buffer Radius drop down list. 
• Select a map layer or All Overlays from the ‘overlay to intersect’ drop down list  
• Click on the location on the map which will form the centre of the circle.  

 
The results will be shown in the Radius Info box under Quick Results.  
 
To see more information about the items found within the radius: 
• Click on the Detailed Results button at the bottom of the Radius Info box (you 

may have to scroll to the bottom of the box to see the button) 
 
To remove the red circle: 
• Click on the drop down button under Tools and click on ‘Layers’  
• Scroll to the bottom of the layer list displayed in the Layer Info box, below the 

tools drop down list 
• Click on the Remove Overlays button at the bottom of the layer list. 
 
Note: 

 Not all map layers contain identifiable items. 
 
 
6.  Printing maps 
 
The printing tool allows you to print a map using the default printer linked to your 
computer.  
 
When you are satisfied with the map displayed in the map window and want to print 
it: 
• Click on the drop down button under Tools and click on ‘Print’ from the list. 
• Follow the instructions in the Print Info box that appears below the Tools drop 

down list: 
• Enter a title for the map 
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• Click on the Print Layout drop down button and click on a suitable layout from 
list. 

 Standard – A4 Square map  
 A4L – A4 Landscape map 
 A4P – A4 Portrait map 

• Click on the Print Preview button. This will automatically create a print 
template for you containing the map and title, copyright statement, logo and 
scale. 

• Select Page Setup from the File Menu and set the  Paper Size and Orientation to 
match the print layout that you set earlier. 

• Select Print from the File Menu and the map will be printed. 
• Click on Return to Mapping at the bottom of the print template or  the Back button 

to return to the main Medway Map Service page. 
 
 
7.  Incorporating maps into Word documents 
 
To copy a map into a Word document: 
• Click on the map in the map window (not the map in the print template) with the 

right hand mouse button. 
• Select Copy from the menu to copy the map into your clipboard. 
• Start Word. 
• Open a new document or the document where the map is to be pasted and click 

on it at the location for pasting the map. 
• Select Paste Special from the Edit menu and choose the format for pasting – 

devise independent bitmap, picture, or jpeg. 
• The map will then be pasted, as a picture, from the clipboard into the file along 

with the OS copyright statement and the map scale. 
 
Note: 

 Unfortunately the map scale will not be preserved when the map is pasted 
into the Word document and should therefore be ignored. 
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